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⦿ Информация о компоненте



НАСТРОЙКА РАБОЧЕЙ СРЕДЫ

⦿ Окно программы после запуска
⦿ Структура и состав панелей меняются в зависимости от типа 

открытого документа и могут отличаться от приведенного. Ко всему 
прочему они настраиваются, что может еще усугубить различие и 
усложнить работу с данным руководством. Поэтому перед началом 
работы приведем панели общему виду, выполнив команду Главное 
меню/View/Desktop Layouts/Default.



НАСТРОЙКА РАБОЧЕЙ СРЕДЫ

⦿ Для начала создадим новый проект. Для этого можно воспользоваться 
ссылками на заглавной странице (навигация как в Интернет 
обозревателе) или через команду  главного меню 
File/Project/Integrated Library. Появится панель с деревом проектов.



НАСТРОЙКА РАБОЧЕЙ СРЕДЫ

⦿ В дереве проектов создается заготовка проекта со стандартным, для 
новых проектов, именем. Сам проект как таковой еще не создан, в 
дереве проектов только намерение. Проект создается после 
сохранения. Что мы и проделаем. Жмем правой кнопкой на названии 
проекта  и выбираем Save Project As… Откроется стандартное окно 
сохранения файла. Выбираем имя и папку для сохранения проекта и 
жмем кнопку Save. Проект AD – это файл с описанием наличия 
документов и связей между ними. Все действия по созданию 
документов, отчетов происходят относительно этого файла и пути в 
нем прописаны относительные. Соответственно новые файлы по 
умолчанию располагаются в папке в которой сохранен сам проект.

⦿  Теперь наш проект существует, правда пока еще пуст. Исправим это. 
Добавим к проекту новый файл (Add New to Project/Schematic 
Library).



НАСТРОЙКА РАБОЧЕЙ СРЕДЫ

⦿ Добавление документов к библиотеке



НАСТРОЙКА РАБОЧЕЙ СРЕДЫ

⦿ Настройка рабочей области

⦿ Нажмем правой кнопкой мыши на рабочую область и в отрывшемся 
меню выберем Options/ Document Options.На вкладке Units выберем 
метрическую систему измерений.



НАСТРОЙКА РАБОЧЕЙ СРЕДЫ

⦿ Настройка рабочей области

⦿ На вкладке Library Editor Options установим требуемый шаг 
координатной сетки и размеры рабочей области.



СОЗДАНИЕ ТРАНЗИСТОРА ВАРИАНТ1

⦿ Для создания новой библиотеки необходимо выполнить: 
File>New>Library>Schematic Library. Сохранить библиотеку командой 
File>Save as в нужную папку. В низу панели Projects отображаются 
активные панели. По умолчанию там уже установлена вкладка SCH 
Library. Для начала создания УГО необходимо сделать её активной. 
После чего интерфейс AD примет вид, как показано на рисунке.



СОЗДАНИЕ ТРАНЗИСТОРА ВАРИАНТ1 

⦿ Настройка рабочей области редактора символов

⦿ Активизировать команду главного меню Tools>>Document Options и 
настроить в диалоговом окне Library Editor Workspace основные 
элементы рабочего пространства редактора библиотек: 

⦿ • Units – систему единиц измерения – установим метрическую систему 
единиц; 

⦿ • Grids>>Snap – сетку захвата при построении графики;

⦿ • Grids>>Visible – сетку, видимую на экране.



СОЗДАНИЕ ТРАНЗИСТОРА ВАРИАНТ 1

⦿ Кроме этого имеется возможность задать менее необходимые на этом 
этапе параметры:

⦿ Style – стиль размеров, по умолчанию заданные стили не 
соответствуют ГОСТ;

⦿ Size – формат листа;

⦿ Border – цвет границы листа;

⦿ Custom size – пользовательский размер листа;

⦿ Show Border – показать границы листа;

⦿ Show Hidden Pins – показать скрытые выводы;

⦿ Always Show Comment/Designator – всегда показывать атрибуты.



СОЗДАНИЕ ТРАНЗИСТОРА ВАРИАНТ 1

⦿ В открытой панели редактирования SCH Library с пустым шаблоном 
Component_1, можно просто переименовать уже существующий 
компонент, или создать новый, и начать процедуру формирования 
символа схемной библиотеки, например, NPN-транзистора.

⦿ 1. Для переименования: указать курсором имя Component_1 и 
активизировать команду главного меню Tools>>Rename Component. 
Внести имя NPN в поле имени окна Rename Component и завершить 
переименование щелчком OK. Для создания нового компонента 
следует нажать кнопку Add под списком компонентов данной 
библиотеки в панели SCH Library и в появившемся окне написать 
название нового компонента.

⦿ 2. Установить точку привязки графики УГО в центр окна 
редактирования командой главного меню Edit>>Jump>>Origin (горячие 
клавиши J, O). На графическом экране окна редактирования эта точка 
помечается перекрестием. Вокруг этой точки обычно строится вся 
графика УГО. В дальнейшем, при вызове логических символов из 
библиотеки и размещении их на поле электрической схемы, 
программа ведет символ за электрическую “горячую точку” – 
окончание линии электрического контакта, ближайшего к точке 
привязки графики.

⦿ 3. Установить шаг сетки. В нашем частном случае целесообразно 
установить шаг сетки захвата 0,5 мм, а шаг видимой сетки 5 мм.



СОЗДАНИЕ ТРАНЗИСТОРА ВАРИАНТ 1

⦿ 4. Вычертить в окне графического редактирования УГО NPN-
транзистора.

⦿ При создании УГО дискретных аналоговых компонентов по ЕСКД 
необходимо сформировать графику УГО и разместить электрические 
контакты схемного элемента (символа) в узлах сетки, единой для 
всех, как аналоговых, так и цифровых компонентов. В качестве такой 
оптимальной сетки при проектировании электрических схем по ЕСКД 
целесообразно использовать сетку с шагом 5 мм. Именно в таком 
модульном шаге формируются, в соответствии с ГОСТ 2.743-91 и ГОСТ 
2.759-82, УГО аналоговых и цифровых интегральных микросхем. 

⦿ УГО биполярного транзистора:



СОЗДАНИЕ ТРАНЗИСТОРА ВАРИАНТ 1

⦿ Рассмотрим особенности формирования схемного символа на примере 
биполярного транзистора. В соответствии с ГОСТ 2.730-73 УГО 
биполярного транзистора формируется геометрическим построением. 
В круге диаметром 12 или 14 мм под углом 60° друг к другу и 
симметрично относительно диаметра строятся два луча. Размер “А” 
между исходной точкой лучей и точкой их пересечения с окружностью 
составляет 9 или 11 мм и определяет все остальные размеры УГО. 
Линия базы транзистора строится на расстоянии 0,5А от исходной 
точки лучей и имеет длину, также равную А (рисунок а).

⦿ При таком построении УГО координаты точек сопряжения элементов 
графики выражаются иррациональными числами. Программа, 
конечно, округляет эти координаты до значения младшего разряда 
машинного слова, но все равно точки присоединения проводников 
схемы не попадают в узлы приемлемой сетки проектирования.

⦿ Представляется рациональным решение, изображенное на рисунке б. 
Линии УГО проводятся через узлы 5-миллиметровой сетки, штрихи 
электрических контактов также имеют длину 5 или 10 мм, а 
окружность, изображающая корпус транзистора (ее изображение, по 
ГОСТ 2.730-73, с изменением ИУС № 6 1989 г., не обязательно), 
смещена вправо так, что ее контур проходит через точки окончания 
линий эмиттера и коллектора. Угол раствора коллектора и эмиттера 
составляет при этом 53°. На глаз различия изображений рисунка 1.5, 
а и б совершенно незаметны.



СОЗДАНИЕ ТРАНЗИСТОРА ВАРИАНТ 1
⦿ Рисование графики символа
⦿ 1) Активизировать команду главного меню Place >>Line. Курсор меняет вид 

на перекрестие. Графический примитив Line представляет собой 
полилинию – все отрезки ломаной линии образуют единый объект.

⦿ 2) Клавишей Tab активизировать функцию настройки ширины линии. 
Открывается диалоговое окно настройки PolyLine : 



СОЗДАНИЕ ТРАНЗИСТОРА ВАРИАНТ 1

⦿ 3) В окно вынесены следующие настройки линии:

⦿ • Line Width – ширина линии: курсором указывается один из вариантов 
ширины:

⦿ – Smallest – тонкая, шириной около 0,1 мм;

⦿ − Small – тонкая − шириной 0,254 мм;

⦿ − Medium – средняя – шириной около 0,5 мм;

⦿ − Large − большая − шириной около 1 мм.

⦿ • Line Style – стиль – сплошная (Solid), точечная (Dotted) или 
пунктирная (Dashed);

⦿ • Color – цвет – выбирается из цветовой палитры, открывающейся по 
щелчку левой клавиши мыши на цветном прямоугольнике;

⦿ • Фигуры, которыми начинается и кончается линия – Start Line Shape и 
End Line Shape – стрелки, точки, квадраты и т.п., или отсутствие 
фигур (None), а также размер этих фигур-наконечников (Line Shape 
Size). Щелчком на ОК завершить настройку. Черчение очередного 
отрезка завершается щелчком правой клавиши мыши или клавишей 
Esc. Перед вычерчиванием линии эмиттера клавишей Tab снова 
активизировать настройку параметров и указать стрелку на конце 
отрезка.



СОЗДАНИЕ ТРАНЗИСТОРА ВАРИАНТ 1

⦿ 4) Активизировать команду черчения дуги Place>>Arc. Клавишей Tab 
активизировать диалог настройки параметров дуги.

⦿ В диалоговом окне указываются параметры:
⦿ • Line Width – ширина линии (как в п.1);
⦿ • Color – цвет;
⦿ • Radius – радиус дуги;
⦿ • Start Angle – начальный угол, в абсолютных координатах;
⦿ • End Angle – конечный угол, также в абсолютных координатах.
⦿ 5) Указать радиус 6 мм, начальный угол 0 (нуль) и конечный угол 

360°. По щелчку ОК вычерчивается окружность диаметром 12 мм.
⦿ 6) Переместить и зафиксировать окружность в таком положении, 

чтобы концы линии эмиттера и коллектора лежали на окружности.



СОЗДАНИЕ ТРАНЗИСТОРА ВАРИАНТ 1

⦿ Присоединение электрических 
выводов

⦿ 1. Активизировать команду 
главного меню Place>>Pin 
(горячие клавиши P, P). На 
графическом экране 
появляется изображение 
электрического контакта, 
перемещающееся за курсором 
по экрану. Точка 
присоединения электрической 
связи к контакту помечена 
косым перекрестием. В 
лексике Altium Designer эта 
точка называется “горячим 
концом” (hot end). При 
совмещении вывода с УГО 
линия вывода должна 
примыкать к УГО 
противоположным концом.

⦿ 2. Перед размещением вывода 
активизировать клавишей Tab 
диалог редактирования его 
свойств. Открывается 
диалоговое окно настройки 
свойств вывода Pin Properties



СОЗДАНИЕ ТРАНЗИСТОРА ВАРИАНТ 1

⦿ Установить следующие свойства вывода:
⦿ • Display Name – логическое имя или функциональное назначение контакта. 

В соответствии с требованиями SPICE-технологии схемотехнического 
моделирования последовательность ввода и обозначений выводов 
транзистора должна быть: коллектор-база-эмиттер. По умолчанию первому 
вводимому контакту дается обозначение 0 (нуль). Изменим это 
обозначение на 1. Обозначения следующих выводов автоматически 
инкрементируются. 

⦿ • Designator – имя или цоколевочное обозначение вывода, используемое 
при автотрассировке. По умолчанию это обозначение совпадает с 
обозначением Display Name и также инкрементируется. Присвоим ему 
также обозначение 1. Целесообразно также отключить видимость 
обозначений выводов, т.к. их функциональное назначение в случае 
транзистора ясно из графики УГО (видимые обозначения будут у выводов 
микросхем).

⦿ • Electrical Type – электрический тип вывода. Для выводов транзистора 
установить тип Passive.

⦿ • Description – текстовое описание функции вывода компонента.
⦿ • В поле Graphical установить:
⦿  - Length – длину линии вывода: установить длину 5 мм.
⦿  - Orientation – ориентация линии: установить угол разворота линии вывода 

(против часовой стрелки, относительно положительного направления оси 
X). Ориентация может также меняться при установке вывода на 
графическом экране последовательными нажатиями клавиши ПРОБЕЛ 
(SPACE).

⦿ • В поле Symbols оставить без изменения признак No Symbol – отсутствие 
указателей полярности, направления передачи сигнала и т.п.
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⦿ 3. Щелчком ОК завершить редактирование свойств вывода и 
установить его на УГО в окне графического редактирования 
компонента.

⦿ 4. Повторить действия пп. 2, 3 для следующих выводов компонента. 
Последовательность ввода оставшихся выводов – база, эмиттер.

⦿ 5. Командой главного меню File>>Save cохранить построенный 
компонент в библиотеке. 

⦿ Но этом создание графики транзистора считается законченным



СОЗДАНИЕ ТРАНЗИСТОРА ВАРИАНТ 2
⦿ САПР Altium Design обладает достаточно полной стандартной 

библиотекой элементов. Поэтому при создании УГО транзистора имеет 
смысл не чертить все с самого начала, а воспользоваться УГО, 
имеющимся в базе Altium Design.

⦿  Для этого необходимо открыть стандартную библиотеку (File/Open). 
Путь по умолчанию: C:\Program Files\Altium Designer Summer 
08\Library\Miscellaneous Devices.IntLib. В появившемся диалоговом 
окне выбираем пункт Extract Sources.
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⦿ Далее находим в 

библиотеке необходимое 
нам УГО, копируем и 
вставляем в свою 
библиотеку. Для этого:

⦿ кликнем в окне менеджере 
проектов на файл 
Miscellaneous Devices.SchLib;

⦿ перейдем к вкладке SCH 
Library;

⦿ найдем необходимое нам 
УГО;

⦿ копируем его в буфер 
обмена;

⦿ переходим в менеджере 
проектов к нашей 
библиотеке (вкладка 
Projects);

⦿ создаем новый компонент 
(вкладка SCH Library, Add);

⦿ вставляем УГО в рабочее 
поле;

⦿ если необходимо 
редактируем цвет, толщину 
линий и т.д.

⦿ открываем окно свойств 
компонента и в поле Default 
Designator вводим VT?.

Остальные УГО создаются аналогично. 
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⦿ К многосекционным компонентам относятся резисторные, 
конденсаторные, диодные и транзисторные сборки и матрицы, 
электрические соединители, некоторые логические интегральные 
микросхемы. Схемный символ многосекционного компонента может 
быть построен целиком, со всеми секциями в едином УГО. В этом 
случае создание такого символа ничем не отличается от 
рассмотренного. Однако, для формирования принципиальной 
электрической схемы, которая бы легко читалась и наглядно 
демонстрировала принцип действия функционального узла, такое 
изображение не всегда удобно.

⦿  Не все секции до одной всегда используются в схеме, а видимость 
неиспользуемых невозможно отключить. В результате схема 
загромождается лишними УГО.

⦿ Из соображений удобочитаемости схемы и понимания ее 
функционирования часто бывает удобно изображать схему 
разнесенным способом. При едином УГО на весь компонент это 
невозможно, и приходится тянуть к нему линии электрической связи 
издалека, что затрудняет чтение схемы.

⦿ Поэтому целесообразно рассмотреть особенности формирования 
схемного символа многосекционного компонента разнесенным 
способом – на примере логической интегральной микросхемы 
К511ПУ2, содержащей 2 двухвходовых вентиля 2И-НЕ и два вентиля И-
НЕ в одном корпусе.
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⦿ 1. Переименовать пустой компонент Component_1 в плавающей панели 
SCH Library, присвоив ему имя К511ПУ2 и установить точку привязки 
графики в центре главного окна графического редактора. 

⦿ 2. Активизировать команду главного меню Place>>Line и вычертить 
квадрат УГО, со стороной 15 мм.

⦿ 3. Активизировать команду главного меню Place>>Pin и вызвать 
клавишей Tab диалог настройки свойств электрического вывода.
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⦿ Назначить первому выводу:

⦿ • обозначение Designator – 1, в соответствии с цоколевкой 
микросхемы, имя Display Name также также назначить Е;

⦿ • электрический тип назначить Passive, чтобы избежать размещения 
меток, противоречащих требованиям ЕСКД;

⦿ Закрыть диалог настройки и зафиксировать первый вывод в главном 
окне графического редактора.

⦿ 5. Продолжить установку следующих выводов. 

⦿ 6. Создав первую ячейку микросхемы, необходимо повторить первые 
два шага и создать остальные три ячейки, при этом на символе 
позиционные обозначения выводов должны совпадать с реальными 
номерами ножек микросхемы. Для создания новой ячейки внутри 
компонента выполняется команда Tools>New Part.
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⦿ Скрытые выводы питания и земли
⦿ Чаще всего это выводы цифровых интегральных схем, подключаемые 

к цепям питания и заземления. При традиционном ручном способе 
черчения электрических схем эти выводы на схеме не показывались, 
а необходимость их присоединения к цепям питания и заземления 
указывалась в текстовых технических требованиях на поле чертежа.

⦿ В P-CAD, Altium Designer и других САПР могут использоваться два 
подхода к формированию и использованию этих выводов при 
выполнении электрической схемы.

⦿ При первом подходе в компонент вводится специальная секция с 
выводами питания и заземления. В терминологии P-CAD такие 
компоненты называются гетерогенными. Цепи питания и заземления 
подводятся к выводам этих секций так же, как и сигнальные цепи к 
выводам логических секций.

⦿ При втором подходе выводы питания и заземления делаются 
скрытыми. Они объединяются программой в цепь с назначенным 
именем (в P-CAD эти цепи имеют статус “глобальных”), и 
разработчику остается только обеспечить вывод этой цепи на контакт 
соединителя или лепесток для подачи питания на плату.

⦿ Рассмотрим процедуру формирования скрытых выводов питания и 
заземления в Altium Designer на примере нашей интегральной 
микросхемы.
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⦿ 1. Активизировать команду главного меню View>>Show Hidden Pins. По 
этой команде делаются видимыми все скрытые выводы компонента, а 
также скрытые имена и другие обозначения у видимых выводов.

⦿ 2. Указать курсором в плавающей панели SCH Library на значок 
компонента KR1564LA3 (всего компонента, а не отдельной секции!!!). 
В главном графическом окне редактора библиотек отображается УГО 
первой секции компонента.

⦿ 3. Активизировать команду главного меню Place>>Pin и вызвать 
клавишей Tab диалог предварительного редактирования свойств 
вывода.

⦿ 4. В диалоговом окне Pin Properties :
⦿ • обозначениям Display и Name Designator присвоить цоколевочный 

номер вывода 7;
⦿ • признаку Electrical Type установить значение Power;
⦿ • составить описание (Description): Ground_pin;
⦿ • указать номер секции (Part Number) 0 (нуль): при таком обозначении 

выводы питания и Земли присоединятся к каждой секции компонента;
⦿ • активизировать признак Hide – скрыть вывод на УГО;
⦿ • в поле Connect to указать имя цепи GND – Земля.
⦿ Щелчком ОК завершить редактирование и зафиксировать вывод в 

ближайшем к контуру УГО узле сетки проектирования.
⦿ 5. Повторить те же действия, установив при этом описание Supply_pin, 

цоколевочный номер вывода 14 и имя цепи питания VCC. Конечный 
результат показан на рисунке.



СОЗДАНИЕ МНОГОСЕКЦИОННЫХ КОМПОНЕНТОВ ВАРИАНТ 1

⦿ 6. Селектируя по очереди секции компонента в плавающей панели SCH 
Library, убедиться, что у каждой секции появились выводы 7 и 14. 
Если это так, снять активность команды главного меню View>>Show 
Hidden Pins.

⦿ 7. Командой главного меню File>>Save сохранить компонент с 
подключенными скрытыми выводами.

⦿ В Altium Designer любой вывод может быть скрытым. Кроме того, 
должна быть явно обозначено имя цепи, к которой подключаются 
скрытые выводы.
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⦿ Для редактирования свойств компонента необходимо вызвать окно свойств 
компонента. 

⦿ В поле Default Designator внести буквенный префикс позиционного обозначения. 
Добавить в строку с префиксом вопросительный знак. При составлении 
электрической схемы на его место в позиционное обозначение вносится порядковый 
номер компонента, в пределах группы функционально однородных. В поле Comment 
вписать строку комментария. В поле Description вписать описание компонента, по 
которому он будет отыскиваться при активизации поисковой системы. В нашем 
случае описание может быть, например, Transistor NPN Generic. Остальные поля в 
правой половине окна остаются пока свободными. Они будут заполняться при 
присоединении к компоненту моделей.
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⦿ Находясь в редакторе схем, выполним команду 
Tools>Configure Pin Swapping, в результате которой на экран 
выводится окно, в котором показаны все компоненты данной 
библиотеки с информацией об эквивалентности (в правых 
столбцах). В списке нужно выбрать необходимый компонент, 
например, ранее созданный К511ПУ2, и нажать кнопку 
Configure component (или двойное нажатие на названии 
компонента в списке). После этого на экране появится окно, 
показанное на рисунке.
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⦿ - Pin Swapping – эквивалентность выводов

⦿ - Differential Pair Swapping – эквивалентность дифференциальных пар

⦿ - Part Swapping – эквивалентность ячеек компонентов

⦿ Для определения группы выводов как логически эквивалентных, 
нужно для всей группы выводов установить одинаковое значение в 
столбце Pin Group.
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⦿ Для запуска проверки, находясь в редакторе библиотеки символов, выполним 
команду Reports>Component Rule Check/ В результате на экране появляется 
окно, в котором две группы проверки. В группе Duplicate проверяется наличие 
одноименных компонентов и одинаковых номеров выводов. В группе Missing 
проверяется наличие описания (Description), посадочного места (Footprint), 
позиционного обозначения (Default Designator), имени вывода (Pin Name), 
номера вывода (Pin Number) и нарушение сквозной нумерации выводов (Missing 
Pins in Sequence). После запуска проверки программа формирует и открывает  
новый файл с расширением ERR и названием, соответствующим названию 
библиотеки. Если библиотека не содержит ошибок, то этот файл будет 
содержать только заголовок, в противном случае будет выдан только отчет об 
ошибках. Перечень ошибок здесь представлен в виде обычного текстового 
файла и нет возможности навигации по ошибкам, как это сделано, например, в 
редакторах схем и плат. Ошибки в библиотеке придется обнаруживать и 
исправлять вручную. В конечном результате после проверки окно файла *.ERR 
не должно содержать списка ошибок.
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⦿ В микросхему KR 1554LA3 
входят четыре логических 
элемента «2И-НЕ». 
Создадим её как 
многосекционный 
компонент, т.е. нарисуем 
сначала один элемент «2И-
НЕ», а потом укажем 
программе, что в одном 
корпусе будут находиться 
четыре таких элемента 
(вентиля). 

⦿ 1) Вычертить 
прямоугольник УГО 15х10 
мм (Place/ Line);

⦿ 2) присоединить  выводы 
(Place/ Pin);

⦿ 3) для каждого из выводов 
указать имя, номер, тип (в 
нашем случае для всех 
Passive), длину и 
ориентацию. Для выхода 
(вывод 3) необходимо 
выбрать Outside Edge/ Dot 
(инвертирующий выход);

⦿ 4) добавит текстовую метку 
& (Place/ Text);

⦿ 5) переименуем наш 
компонент (KR 1554LA3).
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⦿ Теперь необходимо сделать элемент многосекционным. Для этого:
⦿ добавим к элементу необходимое число секций (Tools/ New Part);
⦿ начерченное ранее УГО автоматически переместится в PartA;
⦿ добавим выводы питания и земли. Для этого необходимо включить показ 

скрытых элементов (View/ Show Hidden Pin). Добавим два вывода питания 
(Place/ Pin). В свойствах укажем следующее: 

⦿ для вывода « Питание»: 
⦿ Display Name: 14
⦿ Designator: 14
⦿ Electrical Type: Power
⦿ Description: Vcc
⦿ Hide: yes
⦿ Connect to: Vcc
⦿ Part Number: 0
⦿ для вывода « Земля»: 
⦿ Display Name: 7
⦿ Designator: 7
⦿ Electrical Type: Power
⦿ Description:  Ground
⦿ Hide: yes
⦿ Connect to: GND
⦿ Part Number: 0
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⦿ Теперь поясним, что же мы 
указали в свойствах 
вывода. Display Name – 
подпись вывода, Designator 
– номер вывода 
(используется в 
дальнейшем при 
присоединении 
посадочного места), 
Description – подпись-
пояснение, Hide – скрываем 
выводы (не будут 
показываться на 
принципиальной 
электрической схеме, при 
создании же печатной 
платы они будут 
соединены), Connect to – 
указывает название цепи, к 
которой нам нужно 
подключить вывод, Part 
Number – номер секции 
(для выводов питание 
указывается 0, тем самым 
мы включаем их во все 
секции компонента).

⦿ Для завершения 
редактирования осталось 
указать некоторые свойства 
всего созданного нами 
компонента. Для этого 
сделаем двойной клик по 
нашему компоненту 
(вкладка SCH Library). 
Появится окно свойств 
компонента.
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⦿ Пункт Default Designator – обозначение элемента по умолчанию (для цифровых 
микросхем – DD, для транзисторов – VT и т.д.), после буквенного обозначения 
необходимо поставить знак вопроса для последующей автоматической нумерации 
выводов; Comment – комментарий (можно не заполнять).

⦿ Редактирование многосекционного компонента завершено. Результат показан на 
рисунке (View/Show Hidden Pin включено).
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⦿ Создание посадочного места начинается с создания новой 
библиотеки, для чего выполняется команда File>New>Library>PCB 
Library. В результате на экране после выбора закладки PCB Library 
появляется окно, представленное на рисунке :
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⦿ Для установки настроек выполним команду Tools>Library Options. На 
экране появляется окно, показанное на рисунке:
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⦿ В появившемся окне в поле Unit выбираем систему единиц измерения 
(в нашем случае  метрическую), шаг сетки (Snap Grid),шаг сетки для 
установки компонентов (Component Grid, для библиотек эта сетка не 
используется) и две видимые сетки (Grid 1 и Grid 2).

⦿ Видимые сетки задаются относительно сетки Snap Grid, первая должна 
быть равна шагу сетки, вторую удобно поставить в 10 раз больше. 
Наиболее важной здесь является сетка Electrical Grid, или сетка 
привязки, она определяет прямоугольную область внутри контактной 
площадки, при захвате на которую курсор залипает на центре 
отверстия. Snap On All Layer – привязка на все слои, Snap To Board 
Outline – привязка к углам платы (не используется в редакторе 
посадочных мест). 
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⦿ В свободном поле главного окна щелкнуть левой клавишей, после 
чего нажать несколько раз клавишу Page Up, в результате на экране 
станет видна сетка. В результате выполнения этих шагов рабочее 
пространство оказывается подготовленным для формирования 
посадочных мест компонентов. По умолчанию графический редактор 
имеет структуру слоев, обеспечивающую проектирование 
двухсторонней печатной платы:

⦿ • Top Layer – верхний слой печатных проводников;
⦿ • Bottom Layer – нижний слой печатных проводников;
⦿ • Mechanical 1 – первый “механический” слой (для изображения 

радиаторов, других элементов сборки);
⦿ • Top Overlay – слой шелкографии;
⦿ • Keep-Out Layer – слой барьеров трассировки;
⦿ • Multi-Layer – “мультислой” – слой контактных площадок.
⦿ Формирование посадочного места компонента заключается в 

определении его конструкции и размещении в рабочем пространстве 
редактора PCB Component Editor контактных площадок для 
электрического подсоединения, а также черчении линий контура 
компонента. Линии контура располагаются обычно в слое 
шелкографии Top Overlay. Контактные площадки для монтажа 
компонентов со штыревыми выводами формируются в слое 
Multi-Layer. Контактные площадки для поверхностно-монтируемых 
компонентов формируются в верхнем сигнальном слое Top Layer.
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⦿ Переименовать открытое в панели PCB Library пустое посадочное 
место PCBCOMPONENT_1. Для определенности будем считать, что мы 
формируем посадочное место для отечественного транзистора КТ315. 
Назовем имя этого посадочного места по имени корпуса этого 
транзистора КТ-13. Для присвоения нового имени двойным щелчком 
мыши на имени PCBCOMPONENT_1 в панели PCB Library активизировать 
окно переименования компонента, указать имя КТ-13 и ввести 
описание (Description) – Footprint KT-13.

⦿ Установить точку привязки графики в центр графического листа 
редактора ТПМ. Для этого воспользоваться “горячими” клавишами - 
последовательно нажать J, R. С точки зрения трассировки печатного 
монтажа, может оказаться предпочтительным располагать точку 
привязки не в центре графики, а на “ключевом” выводе компонента. 
Изменить положение точки привязки можно по команде главного 
меню Edit>>Set Reference.
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⦿ Для размещения 
контактных площадок 
необходимо выполнить 
следующую 
последовательность 
действий:

⦿ 1. Активизировать 
команду главного меню 
Place>>Pad (горячие 
клавиши P, P). Перед 
тем, как фиксировать 
плавающую за курсором 
контактную площадку 
(КП) на поле 
графического 
редактора, вызвать 
клавишей Tab диалог 
редактирования ее 
параметров. 
Открывается диалоговое 
окно свойств контактной 
площадки, Pad :
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⦿ 2. В поле Location указать координаты КП на поле графического 
редактора. Указываем координаты 0, 0.

⦿ 3. В поле Hole Information устанавливаем вид и размер отверстия 
КП.

⦿ Возможны следующие варианты формы отверстия:

⦿ • Round – круглое;

⦿ • Square – квадратное;

⦿ • Slot – щель.

⦿ Выбираем круглое отверстие диаметром (Hole Size) 1,4 мм. Такой 
диаметр превышает на 0,4 мм ширину ленточного вывода 
транзисторов в корпусе КТ-13 (требование ГОСТ 10317-79, 
обусловленное необходимостью свободной установки выводов 
компонентов в монтажные отверстия КП).

⦿ 4. В поле Size and Shape выбрать форму и размеры площадки 
металлизации КП. Возможны следующие варианты формы;

⦿ • Round – круглая, а при указании разных размеров по осям X Y – 
овальная форма;

⦿ • Rectangular – прямоугольная форма.



СОЗДАНИЕ БИБЛИОТЕКИ ПОСАДОЧНЫХ МЕСТ

⦿ 5. В поле Properties назначим цоколевочное обозначение КП 
(Designator) – сохраним принятый для схемного символа порядок 
обозначений выводов и обозначим вывод коллектора цифрой 1. Кроме 
цифровых, возможны буквенные (Alphabetic) и смешанные буквенно-
цифровые обозначения выводов(Alphanumeric).

⦿ 6. Зафиксировать сформированную КП на поле графического 
редактора щелчком мыши или клавишей Enter.

⦿ 7. После фиксации на экране первой сформированной КП за курсором 
начинает перемещаться вторая. Зафиксировать вторую и третью КП 
(выводы базы и эмиттера) по разные стороны от вывода коллектора, 
по вертикали, с шагом 2,5 мм. Обозначения Designator при этом 
автоматически инкрементируются.

⦿ 8. Завершить установку КП щелчком правой клавиши мыши или 
клавишей Esc. Сохранить полученный результат командой File>>Save.
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⦿ Черчение контуров корпуса компонента

⦿ 1. Активизировать слой графического редактора Top Overlay, 
предназначенный для изображения контуров компонента в проекции, 
соответствующей способу установки его на плату.

⦿ 2. Активизировать команду главного меню Place>>Line. Клавишей Tab 
вызвать диалог настройки параметров линии. Установить тип линии 
Solid – сплошная, толщину линии Small (0,254 мм).

⦿ 3. Клавишей G активизировать настройку сеток и выбрать активную 
сетку захвата Snap Grid c шагом 0,25 мм.

⦿ 4. Вычертить прямоугольник размерами 3×7,5 мм, с центром 
симметрии в точке расположения КП коллектора (средняя КП из трех). 
Затем прочертить линию фаски с отступом на 1 мм от левого края 
контура.

⦿ Сохранить окончательный результат формирования компонента 
командой File>>Save.



СОЗДАНИЕ БИБЛИОТЕКИ ПОСАДОЧНЫХ МЕСТ

Посадочное место для транзистора 2N3904 

СОЗДАНИЕ БИБЛИОТЕКИ ПОСАДОЧНЫХ МЕСТ



СОЗДАНИЕ БИБЛИОТЕКИ ПОСАДОЧНЫХ МЕСТ

⦿ В структуру контактной 
площадки входят две маски 
– Solder Mask – маска для 
защиты печатных 
проводников от воздействия 
влаги и перетекания припоя 
при монтаже и Paste Mask – 
маска, по форме окон в 
которой выполняется 
трафарет для нанесения 
припойной пасты перед 
пайкой поверхностно-
монтируемых (SMD) 
компонентов. Маски 
формируются на верхней и 
нижней сторонах платы. При 
настройке параметров КП 
есть возможность указать 
величину отступа краев 
отверстий в каждой из 
масок от края площадок 
металлизации на наружных 
слоях. Настройка 
выполняется в полях 
диалогового окна:
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⦿ В поле Paste Mask Expansion активизировать одну из двух опций – Expansion Value 
from Rules либо Specify Expansion Value. В первом случае значение отступа маски 
берется из правил, установленных для всего проекта в конфигурации редактора 
печатной платы командой Design>>Rules. Во втором случае значение отступа 
назначается конструктором.

⦿ Для создания более сложного посадочного места микросхемы лучше 
воспользоваться мастером. Для запуска мастера необходимо выполнить команду 
Tools>Component Wizard. На экране появится диалоговое окно мастера создания 
посадочных мест и после нажатия кнопки Next будет предложено выбрать тип 
корпуса и единиц измерения, как показано на рисунке:

Далее в пошаговом режиме 
необходимо:
-Определить размеры контактных 
площадок 
-Расположение контактных площадок 
относительно друг друга
-Определить толщину линии контура
-Задать количество контактных 
площадок в корпусе (в нашем случае 
14)
-Дать название создаваемому 
корпусу
-Закончить создание корпуса 
нажатием клавиши Finish.
-После завершения работы мастера 
необходимо сохранить библиотеку 
нажатием пиктограммы Save. 
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⦿ Проверка корректности создания посадочных мест проводится аналогично данной 
процедуре в библиотеке символов, т.е. с помощью команды Report>Component Rule 
Check. При этом на экране появится окно, представленное на рисунке.

⦿ Здесь программа проверяет дублирующиеся контактные площадки (Pads), примитивы 
(Primitives) и посадочные места (Footprint). Кроме этого существует проверка 
следующего:

⦿  - Missing Pad Names – пропущенные названия контактных площадок, именно по ним 
автоматически будет проводиться сопоставление выводов символа и ножек 
микросхемы;

⦿  - Offset Component Reference – смещение точки привязки, выдается сообщение в том 
случае, если привязка расположена не в проекции посадочного места;

⦿  - Shorted Copper – пересечение объектов на слое металлизации;

⦿  - Unconnected Copper – неподключенные объекты на слоях металлизации;

⦿  - Check All Components – проверять все  компоненты, в противном случае проверка 
будет выполнена только для активного компонента.

⦿ Поиск и исправление ошибок так же, как и в редакторе символов, выполняются 
вручную. 



ИСПОЛЬЗОВАНИЕ МАСТЕРА ПО 
СОЗДАНИЮ ПОСАДОЧНЫХ МЕСТ
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ПОДКЛЮЧЕНИЕ МОДЕЛИ ПОСАДОЧНОГО МЕСТА К СХЕМНОМУ КОМПОНЕНТУ

⦿ Присоединение моделей делает компонент пригодным к применению 
в сквозном проектировании функциональных узлов. При 
присоединении модели в среде редактора библиотеки схемных 
элементов (Schematic Library Editor) она оказывается связанной с 
компонентом, но ее данные не включаются в состав схемного 
компонента. Это означает, что связываемые модели должны быть 
доступны при формировании библиотек и при помещении компонента 
на лист схемы. Поиск моделей для подключения к компоненту 
происходит в следующей очередности:

⦿ 1) В библиотеках, включенных в дерево текущего проекта. 

⦿ 2) В PCB-библиотеках (но не интегральных библиотеках), входящих в 
список библиотек, включенных в рабочую среду текущего проекта 
функционального узла.

⦿ 3) В любых библиотеках, путь к которым определен командой 
главного меню Project>>Project Options.
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⦿ Будем считать, что топологическое 
посадочное место (ТПМ) для 
разрабатываемого нами компонента 
схемной библиотеки – NPN транзистора 
КТ315 сформировано и сохранено в PCB-
библиотеке PcbLib1.PcbLib под именем 
КТ-13 (название корпуса транзистора 
КТ315).

⦿ 1. Щелчком левой клавиши мыши по 
кнопке Add в поле моделей плавающей 
панели SCH Library активизировать 
процедуру присоединения модели. 
Открывается диалоговое окно Add New 
Model, в нашем случае следует указать 
тип модели – Footprint.

⦿ 2. По щелчку ОК открывается диалоговое 
окно PCB Model с пустыми полями. 
Кнопкой Browse открыть поиск PCB-
библиотеки, содержащей интересующую 
нас топологическую модель.

⦿ 3. Открывается диалоговое окно 
просмотра библиотек Library Browse. 
Поскольку библиотека TPM.PcbLib, 
содержащая ТПМ КТ-13 включена в 
дерево проекта Transistor.LibPkg, поиск 
сразу обнаруживает его. 
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⦿ В полях окна отображается 
имя библиотеки, имя ТПМ и 
его описание, а также 
графическое изображение 
контура и контактных 
площадок. Кнопкой ОК окно 
закрывается, а данные из его 
полей передаются в окно PCB 
Model.

⦿ 4. Завершить процедуру 
подключения ТПМ кнопкой 
ОК. В поле моделей 
плавающей панели Sch Library 
отображаются сведения о 
подключенной модели ТПМ – 
его имя, тип и описание.



СОЗДАНИЕ ИНТЕГРИРОВАННОЙ БИБЛИОТЕКИ

⦿ Для создания схемы достаточно иметь библиотеки 
компонентов в виде *.SchLib и *.PcbLib в структуре проекта, но 
в этом случае усложняется процедура структурирования 
библиотек и последующего оборота библиотек внутри 
предприятия. Файлы библиотек символов рекомендуется 
объединять в проект библиотек, который носит название 
интегрированной библиотеки. Использование 
интегрированной библиотеки имеет следующие 
преимущества: все символы, модели Spice и посадочные 
места хранятся в едином файле, имеется возможность 
компиляции библиотеки, за счет чего достигается ее отладка.

⦿ Для создания интегрированной библиотеки нужно:

⦿ 1. Выполнить команду File>New>Project>Integrated Library, 
после чего в структуре панели Project появится новый 
документ. 

⦿ 2. Сохранить новый документ нажатием правой клавиши мыши 
и выбрав Save Project as в нужную директорию под именем 
Library.
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⦿ 3. Добавить в структуру 
созданного проекта ранее 
созданные библиотеки путем 
их перемещения в дереве 
панели Project. В результате 
получим вид как на рисунке. 
Созданный файл имеет 
расширение *.LibPkg, а не 
*.IntLib, т.е. в настоящий 
момент мы имеем не саму 
интегрированную библиотеку, 
а файл заготовки, из которого 
будет сформирована 
интегрированная библиотека.
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⦿ 4. Щелчком правой клавиши мыши на имени 
библиотечного проекта Library.LibPkg в плавающей 
панели Projects активизировать контекстное меню 
и указать в нем команду Compile Integrated Library 
Transistor.LibPkg.

⦿ 5. Если компиляция проходит без ошибок, 
формируется интегральная библиотека 
Library.IntLib. Библиотека автоматически 
сохраняется в подкаталоге ...\Project Outputs for 
Transistor\Transistor.IntLib того каталога, в котором 
находятся файлы-источники – библиотека схемных 
компонентов и библиотека ТПМ. 

⦿ Файлы описания моделей также копируются и 
компилируются в интегральную библиотеку. Новая 
интегральная библиотека включается в состав 
библиотек, подключенных к рабочему 
пространству Altium Designer, и ее компоненты 
могут в дальнейшем использоваться в сквозном 
проектировании радиоэлектронных 
функциональных узлов.
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⦿ Для того чтобы получить 
возможность использования 
библиотек схемных элементов 
в редакторе электрической 
схемы или посадочных мест 
компонентов в редакторе 
печатной платы, библиотеки 
должны быть включены в 
рабочую среду Altium Designer. 
Процедура включения 
интегрированных библиотек в 
рабочую среду программы 
следующая.

⦿ 1. Активизировать закладку 
Libraries на краю рабочего окна 
программы или выполнить 
последовательность команд в 
главном меню: 
View>>Workspace Panels 
>>System>>Libraries. 
Активизируется плавающая 
панель Libraries.
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⦿ В полях этой панели 
представлено имя одной из ранее 
подключенных библиотек, состав 
ее компонентов и их краткое 
описание, условно-графическое 
обозначение схемного элемента, 
на который указывает курсор 
селекции, сведения о модели 
компонента: в простейшем случае 
это имя топологического 
посадочного места (ТПМ) и 
библиотеки, в которой ТПМ 
хранится, а также его 
графическое изображение.

⦿ Панель может растягиваться или 
сжиматься обычным для окон MS 
Windows способом, перемещаться 
по экрану и “приклеиваться” к 
краям рабочего графического 
окна программы.

⦿ 2. Для присоединения 
недостающих библиотек щелчком 
по кнопке Libraries в верхней 
части панели активизировать окно 
со списком установленных 
библиотек Installed Libraries.
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⦿ 3. Кнопкой Install активизировать стандартный диалог поиска 
библиотек для присоединения их к рабочей среде программы. 
Найденные библиотеки подключить щелчком кнопки Open в окне 
поиска.

⦿ 4. Кнопкой Close завершить подключение библиотек. Если при 
этом было открыто окно текущего проекта электрической схемы, 
выбранные символы подключенных библиотек могут вызываться 
кнопкой Place<Имя_компонента> на поле проектируемой схемы.

⦿ Для исключения ненужных в проекте библиотек вызвать, 
аналогично п.2, диалоговое окно, указать в нем ненужные 
библиотеки и удалить их из списка кнопкой Remove.
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⦿ Altium Designer располагает 
эффективными средствами 
поиска нужного компонента 
в библиотеках, когда путь к 
нему и имя библиотеки 
неизвестно. Поиск 
выполняется следующим 
образом.

⦿ 1. Активизировать поиск 
кнопкой Search в панели 
Libraries. Открывается 
диалоговое окно Libraries 
Search. Возможно два вида 
поиска: упрощенный 
(Simple) и 
усовершенствованный 
(Advanced)
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⦿ 2. В верхнем, текстовом поле окна указать “маску поиска” – написать 
группу символов, которая наверняка является частью имени искомого 
компонента. Звездочки слева и справа от написанных символов 
расширяют поиск на все имена во всех библиотеках, в том числе и не 
подключенных, частью которых является указанная 
последовательность символов.

⦿   3. В поле Scope указать в выпадающем списке Search in тип объектов 
поиска – библиотечные компоненты, посадочные места, трехмерные 
модели или компоненты из баз данных. Область поиска библиотечного 
компонента:

⦿ • Available Libraries – поиск в доступных библиотеках;
⦿ • Libraries on Path – поиск по заданному пути.
⦿ В последнем случае в поле Path указать путь, по которому следует 

искать библиотеки.
⦿ 4. Воспользовавшись улучшенным поиском, кнопкой Helper 

(помощник) может быть активизирована функция расширения маски 
поиска – указаны дополнительные признаки, их логическое сочетание, 
параметры и/или арифметические операции над ними и т.д. 

⦿ 5. Кнопкой Search начать поиск компонента. Результаты поиска 
отображаются в плавающей панели Libraries, в списке Query Results. 
Значки найденных компонентов отображаются в поле просмотра. Имя 
выбранного компонента появляется на кнопке Place в диалоговом 
окне. Щелчком на Place компонент, в зависимости от выполняемой 
стадии проектирования, выносится на поле графического листа схемы 
или печатной платы, где может быть зафиксировано нужное число его 
копий.


